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Preface
The Preparedness Section of the Texas Division of Emergency Management
produces many kinds of documents and other forms of communication for a wide
range of internal and external audiences. Section staff must make frequent editorial
and stylistic decisions, often under tight time constraints.
While the content of our documents varies greatly, the documents themselves must
reflect a standard and consistent approach to communicating information.
Documentation standards, such as those presented here, are the foundation of
professional, trustworthy communication.
This document provides the writing, design and presentation standards that help
staff maintain a uniform tone in a consistent format across all products. These
standards are designed to foster a strong and consistent image for both internal
and external audiences.
To supplement guidelines from the Texas Division of Emergency Management
(TDEM), the Preparedness Section developed these standards and guidelines for
writing, graphics, editorial style and publishing.
Consult Webster’s New World College Dictionary, Fourth Edition, for preferred
spelling, hyphenation and abbreviation. For general style follow The Associated
Press Stylebook and Briefing on Media Law (AP Stylebook), and, where AP is silent,
The Chicago Manual of Style, 17th Edition (University of Chicago Press 2017). For
guidance on clarity and brevity, look to the Federal Plain Language Guidelines
developed by the Plain Language Action and Information Network (PLAIN) under
the Plain Writing Act of 2010. For matters of accessibility and usability we look to
guidelines presented by the U.S. Department of Health and Human Services on
their website at www.hhs.gov/web/508.
This document is intended to provide guidance and is not intended to supersede
any guidance developed by the Texas Division of Emergency Management.
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Overview and Purpose

This document presents standards and guidelines you can use to
create superior communication products. Below are the goal,
objectives and underlying assumptions that guide the development,
maintenance and use of this document.

Goal

Significantly advance the Texas Division of Emergency Management (TDEM)
Preparedness Section’s ability to produce accurate, clear, accessible and
professional communication products that serve and support Texas’ emergency
management community.

Objectives

 Serve as a single, authoritative, user-friendly source of information about style.
 Help staff make consistent decisions about how to document information and
communicate information to others.
 Recommend standards for creating, sharing and managing documents.
 Recommend useful, consistent standards for writing, editing and usage.
 Recommend useful, consistent standards for design and visual presentation.
 Recommend useful, consistent standards for developing accessible documents that
respond to Section 508 guidelines.
 Provide additional guidance to staff working with standard and modifiable wording
in document templates.
 Reiterate Texas Division of Emergency Management (TDEM) style.

Audience

 Preparedness planning unit planners, writers and editors.
 Other interested TDEM planners, planning partners and other stakeholders.

Planning Assumptions

 TDEM plan documents are used by TDEM planners and TDEM planning partners,
emergency responders, community stakeholders, office holders and members of the
interested public.
 TDEM plan documents are used during stressful situations when critical decisions
must be made quickly.
 Documents that are accurate, clear and accessible facilitate efficient and effective
decision-making under pressure.
 Per NIMS guidelines, consistent documentation supports effective emergency
management by ensuring that all stakeholders have access to identical versions of
the same information, regardless of situation or location.
 Style helps ensure consistency and conformity to recognized standards.
 Style inaccuracies delegitimize text by distracting readers, causing them to doubt
the accuracy and authority of the text.
 Style evolves, but only as necessary, since even minor changes have far-reaching
implications.

Documentation Standards

5

Getting Started

Standards for creating and sharing document files streamline
document development, management and publication. This section
explains our standards for creating, naming, saving, sharing and
tracking changes to documents.
Our document development tools are designed to help planners create professional
and publishable documentation efficiently while producing a clear, user-friendly
product. To do this, we have developed a menu of templates with pre-formatted
styles. These tools help speed document development using a clean and clear
document format.

Open a New Document

The plans team creates most documents in Microsoft Word or Microsoft Excel. We
have also developed MS Word document templates for specific uses. Using these
templates helps standardize our communication and the presentation of our brand.
For more information on using templates, refer to Templates in the Visual Style
section of this document.

Name and Save Your Document

Use the following naming convention to name your document:
YEAR_MO_DAY_Document_Name_your-initials
2014_01_15_Firefighting_Annex _jk
File names are less than 50 characters and clearly indicate their content. File names
do not contain spaces or special characters other than the underscore.

Control Document Versions

Because our documents are developed with input from many sources, it is essential
to ensure that there is only one “live” version of a document at any given time.
When two or more people unknowingly work on a document at the same time, they
create two live versions, which someone then must synthesize into one.

Personalize Your Versions

Often two or more people work on a single document in rapid succession on the
same day. When this happens each person adds his or her initials to the end of the
file name of each successive version.
Here is how a document file name would change for a file that was developed by
ak, sent to pt for review, and returned to ak to make corrections:
2018_07_23_Mass_Care_Annex_ak
2018_07_23_Mass_Care_Annex_ak_pt
2018_07_23_Mass_Care_Annex_ak_pt_ak
6
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The document owner changes the file name date if the document is modified at a
later date:
2018_07_26_Mass_Care_Annex_ak
Note that when the date changes, the initials are reset by the document owner.

Track Changes for Internal Reviews

When editing a document in MS Word, use “Track Changes” to capture a history of
changes made. To use Track Changes, go to the MS Word ribbon and select the
Review tab. Click “Track Changes” in the ribbon.

Track-Changes Etiquette

When you respond to a reviewer’s comments on a document, prepare a revised
draft in which you “accept” and respond to the reviewer’s comments. When you
return your revision to the reviewer, remove the reviewer’s original comments but
track and show your revisions. An exception is made when the reviewer poses a
question and expects an answer. All previous versions, with comments, are
preserved in the document’s draft folder on a shared drive.

Use AP Proofreading Marks

When editing a printed copy of the document, use Associated Press (AP) style
proofreading marks found in the back of the AP Stylebook (Associated Press 2017).

A Word about Plagiarism and Copyright

Always cite your sources. You may paraphrase, but doing so requires changing both
words and sentence structure. Citations are still required when you paraphrase. For
more information, refer to References below.
All information in our documentation is original content that we created or, if not,
used with the permission of the copyright holder. This is true for both text and
images. Do not assume that content in U.S. government publications may be used
verbatim without permission.
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Getting Started Checklist

Use this checklist to make sure you are creating, saving and sharing documents
according to plans team guidelines.
Complete

Task
Name the document using a standard naming convention.
Save the document to the correct location on a shared server
or drive.
Control document versions, making sure there is only one
“live” version at any given time.
Save previous versions of the document in a “Drafts” or
“Archive” folder on a shared server or drive.
Personalize versions of the document.
Use the “Track Changes” feature in MS Word to make and
track edits and comments among multiple reviewers.
Return clean versions of the document to reviewers.
Use Associated Press (AP) proofreading marks when editing a
hardcopy.
Cite all sources and check with your supervisor or the
Publications Management Unit if in doubt.
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Developing Content

Creating and revising content is the basic work of document
development. This section offers guidance on crafting plans, annexes
and other documentation.
Many Plans team documents follow a prescribed format and involve extensive
collaboration with dozens of contributors. Planners receive, revise and synthesize
information into a coherent whole that documents vital aspects of the state’s
emergency preparedness.
Other documents are less structured and less collaborative, but they are not
necessarily less demanding. Whatever the case, documentation is more effective
when it is developed with the following basic guidelines in mind:





Understand and speak to the audience.
Organize content effectively.
Express information clearly and concisely.
Use lists, tables and graphics effectively.
Effective documents are also carefully edited and polished according to established
standards for accuracy, consistency and quality. For more information, refer to the
Language Style, Visual Style, and Accessible Style sections below.

Know the Audience

It is important to know the audience for any communication. Most people take this
for granted in face-to-face conversation, but tend to forget it when they write.
Before you start writing, use the following questions to understand the audience:







Who are they and why are they reading the document?
What information do they expect to find there and why do they want it?
How much do they know about the topic?
What are their biases and opinions about it?
How do they judge the accuracy and reliability of this information?
What standard do they use to judge the value of this information?
You may not be able to answer some of these questions. Others may not be
relevant. One or two, however, might lead you to an important insight, making
your document more effective, because understanding your audience is as
important as understanding your topic.

Documentation Standards
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Use the Active Voice

Use the active voice since it usually results in a clearer, more concrete statement.
Write sentences that follow the form subject-verb-object. Compare the active and
passive voice examples below:
Active

Passive

TDEM coordinates mass care operations.

Mass care operations are coordinated by
TDEM.

The State’s Mass Care Coordinator
assesses overall mass care needs.

The state’s overall mass care needs are
assessed by the State Mass Care
Coordinator.

The SOC uses several tools to gather and
analyze data and reports.

Several tools are used by the SOC to
gather and analyze data and reports.

The active voice statements are more direct. They describe action and are easier to
understand, which readers appreciate.

Write in the Third Person

Although this document is written using the second-person point of view, most plan
documents are written using the third person point of view. The third-person point
of view creates a more appropriately sober and neutral tone. Unfortunately, this
point of view often leads to passive voice constructions. Avoid them whenever
possible.

Use the Present Tense

Plan documents that either describe or compel action are written with this basic
planning assumption: our readers are either responding to an incident as it occurs,
or they are reading on behalf of those who do. In either case, it is not helpful or
necessarily accurate to describe future conditions. As an incident unfolds, so does a
structured, well-coordinated response, moment by moment, in the present tense.
Therefore, avoid using the future tense will, which implies more knowledge and
control of future events and conditions than we as planners possess.
Similarly, state emergency management plan documents do not use the word
should. State plan documents and annexes are not prescriptive.

Get Organized

A strong structure is the basis of most effective writing, especially technical writing
or writing that explains a process. If you are following a prescribed structure, such
as that of an annex to the State of Texas Emergency Management Plan, decisions
about how the content is organized and presented are required.
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A Simple Approach

Simple as it sounds, organizing your subject into a basic outline keeps you focused
on your goal: an accurate, clear and concise presentation of the material.
Try this method:
1.
2.
3.
4.

Write down the main topic or main heading.
List the subtopics or headings in any order they occur to you.
Review the main heading: is it still accurate and complete?
Review the subtopics:
a. Are they the same level of importance?
b. Do they all fit beneath the main topic?
c. Are any missing?
5. Order the subtopics based on what the intended audience needs to know first,
second, third and so on, beginning with the basic facts.
6. Build out the subtopics with sub-subtopics.
7. Review the outline, testing its logic and organization.
This is the point at which to validate the outline’s organization. The outline may
change significantly because of new information, something you didn’t foresee, or
because something just doesn’t look right. As annoying as this is, it is less
frustrating than making the same changes to a document that has been drafted and
reviewed.
Focusing on the structure and organization of the content helps you stay focused on
your communication goal. It provides a roadmap through the document’s
information landscape. With such a roadmap, you are less likely to be delayed and
distracted by the details of expression.

Additional Organizational Ideas and Tips

 Organize material in the order in which the audience expects to see it.

 Put the most important information at the beginning.
 Put general information first, followed by specialized information or exceptions.
 If your content addresses a process, organize it chronologically.

Keep It Simple

As you draft the document, try to present information as concisely and clearly as
possible. Doing so helps readers process and understand information, especially
those readers who cannot or do not have time to read in depth.
Often we trade accuracy for simplicity: we explain something clearly and quickly or
we explain it accurately and completely. Plan documents, however, strive to be all
of these: accurate, complete, clear and concise. Here are some tips:

Start with the Main Idea

Write the most important things you want to say about the topic first. Start with the
main points before writing about conditions or exceptions. It may help to write
everything out at once, knowing you can edit later.

Documentation Standards
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Shorten Long Sentences

After finishing the draft, you begin to prune. Keep sentences short and simple: 20
words or less. Sentences need only express one idea or complete thought. Complex
sentences can usually be improved by breaking them into two shorter sentences.
Make sure the point is still clear. Do not use italics or other typographic devices to
emphasize or clarify meaning.

Write Short Paragraphs

When you shorten sentences, you often clarify the information. Similarly, keep
paragraphs short, between four and six sentences. This guides your readers
through the content and keeps them on track.

Use Descriptive Headings

Help readers skim for information by writing short paragraphs and descriptive
headings that clearly identify the content. The paragraph headings probably match
topics and subtopics in the outline.

Write for a Sixth Grader

Follow the newspaper guideline of using simple language. Documents are simple
and clear enough to be read and acted on by non-specialists with limited
vocabularies. Although not always accurate, MS Word allows you to check a
document’s readability, or grade level. 1 Our plan documents are written at a sixth
grade reading level.

Use a Thesaurus

While drafting a document, keep the thesaurus in MS Word open to find shorter,
simpler words. To find the thesaurus, go to the “Review” tab in the ribbon and
select “Thesaurus.”

Eliminate Clutter

Eliminate empty, clunky language, such as the following official-sounding phrases:








as appropriate
at this point in time
in response to
of a similar nature
take into consideration
with your permission
with respect to

Eliminate Redundancies

Look for and remove redundancies, which often hide in tired or trite expressions,
such as the following:
 advance planning (or warning)
 integral part
 mutual cooperation
1

For more information, refer to the Microsoft office website: http://office.microsoft.com/enus/word-help/test-your-document-s-readability-HP010354286.aspx
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root cause
separate entities
serious danger
violent explosion
The Federal Plain Language Guidelines 2 provide useful advice and tips for
eliminating clutter and developing clear and concise documents.

Schedule Review Time

Finally, schedule time in the project plan to review your work with fresh eyes. What
sounded clear when it was first written may sound less clear when read later.
Alternatively, ask another planner to read your document. Ideally this is someone
who is not familiar with its content and is therefore more likely to notice things
others have missed.

Be Graphic

Many people process visual information faster than they do verbal information. This
is one reason why emergency communication relies on color, shape and contrast to
communicate information. Further, many people would rather look at information in
a table, chart or simple diagram than several paragraphs of dense text.
When creating content, it is usually best to develop an outline before developing
graphics. If you are facing several pages of dense text, try thinking about the
information differently. Begin with these questions:







How does the information look at first glance?
What form has it been given?
How is the information organized?
Are there headings? If so, how many levels are there?
Are there any visuals, such as vertical lists, examples, tables, diagrams or maps?
If not, are there opportunities to use them?
It is important, of course, to understand the content before dividing it up visually
and verbally. As a subject-matter expert, however, do not forget your first
impression of the material. Recall what was initially confusing and attack any
lingering ambiguities. A solid wall of opaque text involves more than adding a
photo, a caption or a table to unlock its meaning.
After examining the content, identify opportunities to replace words with a visual
device, so that words and graphics combine for the most effective presentation. Use
the following table as a guide. For more information on each element refer to
Language Style and Visual Style below.

2

For more information, refer to Federal Plain Language Guidelines at
http://www.plainlanguage.gov/.

Documentation Standards

13

Device

When to Use

Bullet List

Numbered List

Use similarly to bullets, but reserve numbers for steps in a
sequence.

Examples

Examples pause the flow of information, allowing readers to
confirm their understanding. Examples can be set off from the
text but are not ancillary.

Tables

Use tables to clarify relationships among categories of
information when these relationships are difficult to infer from
text alone.

Charts and Graphs

Maps

Diagrams
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Use bullets to highlight examples, items in a series, or
exceptions. Bullets work best when used with single words or
short phrases.

Charts and graphs quantify and compare information in
dramatic and effective ways. Plans documents tend not to deal
with comparative data, but these devices are used as needed.
Use as needed, but make sure the map appears in the
document large enough to read. Miniature maps are not
helpful.
Use MS Visio to draw diagrams of complex processes.

Illustrations

Use to show a detailed or expanded view of a thing or system
or to isolate key information.

Photographs

Use to bring visual interest and life to content, but make sure
they convey information and are not decorative.

Documentation Standards

Developing Content Checklist

Use this checklist to help you develop your content.
Developing Content Checklist
Understand the intended audience and the circumstances under which they
are reading the document.
Understand why this information is important to your audience.
Understand what your audience knows about the topic.
Use the active voice.
Write in the present tense.
Write using the third-person point of view.
Avoid using the words will or should.
Write from an outline.
Use short sentences and short paragraphs.
Write at a sixth grade reading level.
Remove empty, cluttered and redundant language.
Schedule time to review the document with fresh eyes.
Use graphic devices to convey information effectively.

Documentation Standards
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Language Style

Planners apply professional editing standards to documentation and
communication because much of it is official guidance and
represents Texas to stakeholders. Look here for help with style and
usage so that your writing is accurate, clear, consistent and
professional.
Our documents follow the conventions of standard written English. When there is
more than one right way to write something, such as two-thirds and 2/3rds, we
choose one way and stick with it. This is what editors, publishers and other
communication professionals refer to as style. Following a consistent style reflects
an attention to detail and helps build trust with our audience. Inconsistencies erode
trust.
The following guidelines present the language style standards for plans
documentation and related communication. They are listed by topic in alphabetical
order. Find corresponding visual style standards in the Visual Style section. Find
frequently used terms in the Common Planning Term Usage section. Remember too
that you can search MS Word and most PDF documents by pressing Ctrl+F to
display the search window.

Abbreviations and Acronyms

Abbreviations and acronyms, which are words formed with letters from a longer
phrase, save time and space. Although they help specialists communicate quickly,
they usually confuse non-specialists. To help ensure communication is inclusive and
widely accessible, use abbreviations sparingly. For more information, refer to the
State of Texas Acronyms and Terms (STAT) Book, which is available with the State
Plan on the TDEM website.
Write the first appearance of an abbreviation in parentheses following the full name
or term, as shown in the following example:
In collaboration with state agencies and other stakeholders, the Texas
Division of Emergency Management (TDEM) implements programs to
increase public awareness. In addition, TDEM coordinates emergency
planning and training.
Start the process over at the beginning of each new section that begins with a main
heading. For more information on section headings, refer to Design Elements
below.
Do not use abbreviations in headings or to start a sentence unless the abbreviation
is well known or has already been used many times in the document.
Use the singular form in first appearance: Letters of Agreement (LOA). Use the
plural version, without an apostrophe, as needed after that: LOAs must be signed.
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If uncertain of the abbreviation’s correct form, refer to the STAT Book, which
contains most of the abbreviations and acronyms used in Texas emergency
management planning.

Capitalization

Whether to capitalize a word or not often depends on how it is being used. Use a
capital letter only if necessary according to the following guidelines.

Abbreviations and Acronyms

The letters in abbreviations and acronyms are usually capitalized. You can confirm
capitalization by referring to Common Planning Term Usage, below, or the STAT
Book.

Names of Organizational Divisions

Capitalize words such as city, state or federal when used as part of an official name
or title. When such words stand alone, even if they refer to a particular
organization, they appear lowercase, as is shown in the following table.
Capitalize

Lowercase

Austin City Council.

She was the city’s longest serving mayor.

This information appears in the State of
Texas Emergency Management Plan.

It is one of the state’s many defenses
against emergencies and unforeseen
incidents.

It was presented by the Federal
Emergency Management Agency.

We researched federal guidance before we
made our recommendation.

Department, Division, Section, Unit

Capitalize only when used as part of a name or title; otherwise use lowercase as
shown in the following table.
Capitalize

Lowercase

Texas Division of Emergency Management.

The division maintains six satellite offices.

The Preparedness Section is located in
another building.

Several members of this section were
activated during the recent storm.

The Local and Regional Plans Unit works
with local emergency management
planners.

Members from this unit visit local and
regional planners throughout the state.
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Document Titles and Headings: The Five Letter Rule

Follow these guidelines for capitalizing titles and headings. Here capitalization
means capitalizing the first letter of the word. Words in titles are never written in all
caps unless the word is an acronym.
Guideline

Example

Capitalize the first word, the last word, and
the main words in between.

 Engineering Principles and Practices
 A Design Manual for Architects
 The Benefits of Strategic Planning

Capitalize conjunctions and prepositions of
five or more letters.

 Flooding and High Winds
 Assistance or Referrals for Special Cases
 Establish Security Whenever Disaster
Strikes
 Preparing for a Drinking Water
Emergency
 Taking Shelter from Hurricanes

These rules apply when a single title
appears on two lines.

A Field Manual
for Incident Commanders

However, titles and subtitles separated by
a line break are treated as two separate
titles.

Incident Debris
A Guide for Planners

If the same title and subtitle appeared on
one line, they would be separated by a
colon.

Incident Debris: A Guide for Planners

Capitalize the first element of a
hyphenated term. Capitalize subsequent
elements unless they are articles,
conjunctions or prepositions of less than
four letters.

 A Report on Counter-Terrorism
Strategies
 Addressing English-Speaking Residents
 Dealing with the After-Shock
 Monitoring Out-of-the-Way Locations

Formal Titles

Capitalize formal titles only when used as part of a person’s name, as shown in the
table below.
Capitalized

Lowercase

Chief Matthews

The chief called the meeting.

Captain Pat Matthews

The captain attended the meeting.

Pat Matthews, State Coordinator

Four state coordinators also attended.

Pat Matthews, Unit Supervisor

Five unit supervisors attended by phone.
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Captions

Write captions for all images, such as photos and illustrations. Captions are brief
yet descriptive because screen reading software reads them aloud to those with
impaired vision. For more information on writing informative captions, refer to
Accessible Images and Captions below. For more information on formatting
captions, refer to Images and Captions below.

Dates and Time

Dates and time are expressed in a standard, familiar format.

Dates

Write dates in the month-day-year format as shown in the table below. When
writing a month and year only, do not separate the two with a comma.
Guideline

Example

Write the month, day and year in standard
format.

 July 30, 2003
 December 3, 1980
 Friday, February 21, 2014

When writing a month and year only, do
not separate the two with a comma.

 July 2003
 December 1980

Do not abbreviate the month or the day. Do not add “nd,” “rd” or “th” after the day.
Standard

Non-Standard

 Friday, February 21, 2014
 February 21
 Tuesday, December 3, 1980

 Fri.
 Feb. 21
 Dec. 3, 1980

 February 21
 December 3, 1980

 February 21st
 December 3rd

Meeting Date and Time

Except for meeting invitations and notices to invitees, refer to meeting occurrence
by date only. If the time and place changes, you need only update those who are
involved.

Time

Write time according to the guidelines presented in the table below.
Guideline

Example

Specify time of day in twelve-hour
increments, either a.m. or p.m., rather
than military time.

 3:30 p.m.
 3 p.m.
 12:45 a.m.

The designations a.m. and p.m. are written
lowercase with periods and no spaces in
between.

 4:30 p.m.
 4 p.m.
 6:15 a.m.

Documentation Standards
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Guideline

Example

Use a colon to separate hours from
minutes. It is not necessary to show
minutes at the top of the hour.

 10:25 p.m.
 10 p.m.

Indicate a time span by placing a hyphen,
no space, between the two times.

 4-5 p.m.
 4:30-5 p.m.
 8:30-9 a.m.

Footnotes

Insert footnotes after closing parenthesis if inserted in the middle of a sentence
(like this) 3 or after ending punctuation. 4 Footnotes are also used to cross-reference
information from a document that TDEM does not publish. For more information,
refer to References below.

Italics

Use italics as described in the following table:
Guideline

Example

Titles of books, films, periodicals

The July issue of Emergency Management

Technical terminology at first use

The process of closing and securing the
facility is known as decommissioning.

Words as words, letters as letters and
numbers as numbers

Avoid using the loaded term victim.
All registration codes begin with the letter
H followed by a 1, 2 or 3.

Rarely, for emphasis if the emphasis is
necessary and might otherwise be lost

Cyberattacks are not the only threat, but
they are the greatest threat.

For more information on the distinctive treatment of words, refer to Font Styling in
the Visual Style section below.

Lists

Vertical lists, words that are stacked, flush left, follow certain language guidelines.

Capitalization and Punctuation

Capitalize the first letter of each list item regardless of whether or not it begins a
sentence. If one or more items are complete sentences, end every item with a
period; otherwise, do not end list items with periods.

Levels

Do not develop lists of more than two levels of indention.

3
4

First example
Second example
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Introducing a List

Introduce lists with a complete sentence that announces what is to come. Use
words such as “the following tasks” or “as outlined below,” followed by a colon. Do
not introduce the list with the start of a sentence that is completed by each item in
the list.
Standard

Non-Standard

Each jurisdiction’s responsibilities include
the following tasks:
 Decision-making support or guidance
 Perimeter security and access control
 Providing reentry placard templates and
guidance

The responsibility for carrying out these
tasks belongs to each jurisdiction and
includes:
 Decision-making support or guidance
 Perimeter security and access control
 Providing reentry placard templates and
guidance

Parallel Construction

In any given list, write the list items using the same (or parallel) sentence form. For
example, make all the items on your list a declarative sentence or make them all
questions, but don’t make some items declarative sentences and some questions or
phrases or single words.
Standard

Non-Standard

 Determine staff requirements.
 Identify personnel who can fill
emergency duty positions.
 Train agency representatives according
to NIMS requirements.
 Develop and maintain contact lists.
 Develop and maintain notification
procedures.
 Develop and maintain agency resources
lists.

 Have staff requirements been
determined?
 Agency personnel, as assigned, should
identify specific personnel who can fill
extended emergency duty positions.
 Agency representatives should be
trained in accordance with NIMS
requirements.
 Have contact lists, as well as notification
procedures, developed and maintain
them regularly.
 Have your lists of agency resources been
developed?

Bullets Versus Numbered Lists

List items, whether bulleted or numbered, only when there is more than one item.
Bullets are most commonly used and do not imply sequence.
Numbers are only used to imply sequence or order. Note that the information in
extensive or complex numbered lists might best be presented as a process
diagram.
Do not use the MS Word list format on the Home tab. The Word default bullet style
does not match ours. Instead, use the bullet or the numbered list quick styles in the
template. For more information, refer to Bullets and Numbers in the Visual Style
section below.
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Numbers

Write numbers in a format that is familiar for most people or most members of a
specialized audience. We follow more specific guidelines depending on how a given
number is used.

Numbers in Text

In regular text, such as a paragraph or sentence, numbers one through nine are
spelled out because this makes them easier to read. Write numbers 10 and greater
as Arabic or Roman numerals. Roman numerals are used when they are part of a
name, such as Region IV.
Guideline

Example

Spell out numbers one through nine.

 Planners agreed on four objectives.
 There are three basic strategies.

Write numbers 10 and above as Arabic
numerals.

 All 25 planning team members attended.
 They sheltered more than 50,000
evacuees.

Numbers that begin a sentence must be
spelled out except for years.

 Twenty team members attended.
 1965 was the last year of the drought.

Exception: some numbers are written as
Roman numerals according to custom or as
part of a name or title.

 Region IV submitted the first request.
 They discussed Implementation Phase V.

An amount of less than one unit is
considered singular. An amount greater
than one unit is considered plural.






Exception: only use Arabic numerals and
decimals with the word percent.

 They exceeded the target by 23 percent.
 The probability of this occurrence
decreased by 0.09 percent.

0.35 meter
0.55 cubic foot
1.75 kilometers
43.01 inches

Numbers in Tables

Numbers in tables follow specific rules for tabular data, as shown in the table
below. For more information, refer to Tables below.
Guideline

Example

Use Arabic or Roman numerals only.

 122
 I, II, III, IV

Convert fractions to decimals up to two
places unless required to use more.

 8.25
 1.333

For amounts less than 1, place a zero
before the decimal point.

 0.75
 0.03
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Plurals

Plurals are normally formed by adding s, es, or ies according to correct spelling.
Sometimes there is more than one standard form of plural. If this is the case we
use the first listed plural spelling in the standard dictionary. 5 In such cases, use the
first listed plural spelling. Do not form a plural by adding ‘s, which forms a
possessive, as discussed under Apostrophe below.

Punctuation

Use the Spell Check function in MS Word. If there is disagreement between Spell
Check and this document, follow this document.

Ampersand (&)

Do not use ampersands because they are not recognized by screen reading
software and therefore not accessible to the vision-impaired. For more information
on accessible style guidelines, refer to Accessible Style below.

Apostrophe

In most cases, adding an apostrophe, followed by an s (‘s) forms the possessive
case. Refer to the AP Stylebook or consult the following table for special cases.

Commas

Avoid unnecessary commas. We follow AP Style by not using the serial (or Oxford)
comma unless the comma is needed for clarity. Therefore, we omit the final comma
in a series before the coordinating conjunction:

Commas in a Series
Guideline

Example

Use commas to separate elements in a
series, but do not put a comma before the
conjunction in a simple series.

The resources included water, food and
shelter.

Commas Between Equal Adjectives
Guideline

Example

Use a comma to separate adjectives equal
in rank; that is, if the comma could be
replaced by the word and without changing
meaning.

an appropriate, effective response

Use no comma when the last adjective
before a noun outranks its predecessors
because it is an integral element of a noun
phrase.

sustained wind speed (the noun phrase is
wind speed)

5

Find our standard dictionary, Webster’s New World College Dictionary, Fourth Edition, in
the Plans Management library.
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Commas with Nonessential Clauses or Phrases

Use commas to set nonessential clauses or phrases apart from the rest of the
sentence. Do not use commas to set off essential clauses or phrases.

Commas with Introductory Clauses
Guideline

Example

Use to separate an introductory clause or
phrase from the main clause.

When the planner was ready to convene
the planning team, she sent an email to all
team members.

The comma may be omitted after short
introductory phrases if no ambiguity would
result.

During the first meeting they established
the planning process.

But use the comma if its omission would
slow comprehension.

In the meeting room, the planner
answered questions.

Commas with Conjunctions (Compound Sentences)
Guideline

Example

Use a comma before conjunctions like and,
but or for when the conjunction links two
clauses that could stand alone as separate
sentences.

Reception centers receive evacuees, and
medics evaluate their needs.

Use a comma if the subject of each clause
is expressly stated.

The lead agency has primary responsibility,
and the lead agency communicates with
supporting agencies.

You do not need to use a comma with two
short clauses that have expressly stated
subjects.

We are meeting and they are planning.

Dash

Use a dash to set off a series of words which themselves are separated by commas:
Emergency Management Coordination at all levels — local, regional, state
and federal — is outlined in the next section.
Follow these guidelines when using dashes.
 Create a dash using the MS Word keyboard shortcut Alt+Ctrl+Num-. The last key is
the minus sign, which is located on the number keypad.
 Insert one space on either side of a dash.
 Do not use a hyphen instead of a dash. For more information, refer to Hyphen
below.
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Hyphen

Use hyphens in the following ways to clarify your meaning.
Guideline

Examples

Use hyphens to join two or more words
into a single idea to help clarify meaning.






life-safety hazard
systems-tracking capability
large-scale hurricane
up-to-date situation reports

You may use a hyphen to create a prefix
after you have checked a standard
dictionary for spelling. If more than one
spelling is provided, use the first-listed
spelling. Refer to the AP Stylebook for rules
on creating prefixes and suffixes.






pre-identified
sub-subparagraph
non-emergency
The damage is hurricane-related.

Use a hyphen to indicate a span of time.

 7-8:30 a.m.
 7-10 p.m.

Parentheses

We avoid using parentheses because they can imply that the information they
contain is nonessential. Consider using commas or revising the information so that
parentheses are not necessary. If you must use parentheses, follow these
guidelines:
 Place end punctuation outside the closing parenthesis if the material inside the
parentheses is not a sentence (such as this fragment).
 (Put a period before the closing parenthesis of an independent parenthetical
sentence, such as this one.)
 Insert footnotes after closing parenthesis (like this) when the reference appears
mid-sentence.

Periods

 Use a single space after the period.
 Put periods inside quotation marks and use a single space after the quotation mark.
 Do not add a period to the end of a sentence that already ends with an abbreviation
ending in a period.

Possessives

Refer to Apostrophe above.

Quotation Marks

 Use open-quote marks (“) and close-quote marks (”) to surround quoted material.
 A word or words being introduced to readers may be placed in quotation marks on
first reference. Do not put subsequent references in quotations.
 The period and the comma always go within the quotation marks.
 Put other forms of punctuation inside quotation marks if the punctuation applies
only to the quoted matter. Put them outside quotation marks when they apply to
the whole sentence.
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Semicolon

Use the semicolon to indicate a greater separation of thought and information than
a comma can convey, but less than the separation that a period implies.
Guideline






Examples

Use semicolons to separate a series when
the items are long or when individual
segments must be set off by commas.

The plan details roles and responsibilities;
provides step-by-step guidance; and
facilitates communication between local,
regional, tribal, state and federal partners.

Use a semicolon when a coordinating
conjunction, such as and, but or for, is not
present.

The fuel coordination team initiated the
conference call; it started on time.

Slash

Use 24/7 to mean 24 hours a day, seven days a week.
Use with fractions and in Internet URLs.
Minimize your use of and/or by deciding whether you mean “and” or “or.”
Do not add spaces on either side of a slash.

References

Documents may reference information that appears elsewhere in the document or
in another document altogether. Format references according to the type and
location of the source, as shown below.
Reference Type

Reference Format

Cross-reference within the same document

In-text, italics, document color

Reference to any other outside source

Footnote and bibliographic entry

The format for each type of reference is described in detail below, including
variations for using hyperlinks and electronic sources. These formats are loosely
based on The Chicago Manual of Style footnote and bibliographic documentation
style.

Standard Reference Wording

Use the following standard wording to introduce references either in running text or
in a footnote:
For more information, refer to [x].
or
For more information on [y], refer to [z].

References to Information Sources

References to outside sources help substantiate and validate published information.
Such references are styled as footnotes at point of use and appear as bibliographic
entries on the “References” page.

26

Documentation Standards

We recommend a modified footnote and bibliographic style. Therefore, we do not
use the “Insert Citation” feature in MS Word. Instead, we enter bibliographic
information into Word in the “Manage Sources” function. Complete instructions for
doing so appear below. Before entering bibliographic information, however, you
must know the following about each of your sources:
 What type of source is it?
 How is it used?
 Will it be hyperlinked?

Types of Outside Sources

As your document develops, keep your source information handy so you can enter
it into MS Word’s format for managing references. Use the following table to help
you decide how each source is to be treated.
Drop-Down Format

Reference Source

Keep in Mind

State laws and governmental
codes

N/A

Enter these references on the
“Authority” page. For more
information, refer to Authority
below.

Books, including dictionaries,
encyclopedias and multivolume works that are not
journals or periodicals

“Book”

Choose “Book.” Avoid selfpublished, vanity press or
little-known industry
association publishers.

Professional, academic or
trade journal articles

“Journal Article”

Many journals are peer
reviewed and have high
editorial standards

Popular magazine and
newspaper articles

“Article in a Periodical”

Cite established publications
with high journalistic
standards.

Published information
accessed online

“Document From Web
site”

Use information that has been
evaluated by a reliable source.

Information that is unavailable
in traditional print format but
is available on a
governmental, agency or
educational institution’s
website

“Electronic Source”

Use information that has been
evaluated by a reliable source.

How to Footnote Outside Sources

Part of using sources well means introducing them at point of use correctly,
consistently and unobtrusively. To insert a footnote to an outside source, use the
footnote feature in Word. First, decide where the in-text footnote reference is to
appear. Position your cursor after the word or phrase and any nearby punctuation,
such as a comma or a period. Then, insert the footnote following these steps:
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1.
2.
3.
4.
5.
6.
7.
8.

In the Ribbon choose “References.”
Choose “Insert Footnote.”
Enter the text of the footnote in the field that opens at the bottom of the page.
Follow these steps to insert a footnote in your MS Word document:
Position your cursor where you want the superscript footnote number to appear.
In the ribbon select the “References” tab.
Choose “Insert Footnote.”
Click “Insert.”
A superscript number appears, and a corresponding number and space appears at
the bottom of the page where you can type the text of your footnote.
The text of the footnote begins with our standard reference wording, “For more
information, refer to. . . .” or “For more information on [x], refer to. . . .”
Follow this introduction with a brief but useful reference to the author or institution
and title of the work or article. To be useful, the reference includes just enough
information to connect it with the full bibliographical reference on the References
page.
If you wish to include an author’s name in the footnote, write the author’s name in
natural order rather than last-name-first-name bibliographic order.
If the source includes a hyperlink, include the link behind the title of the work. The
bibliographic entry on the References page will reproduce the full URL without the
link.
Consider the following examples:
Footnote
5

For more information, refer to The National Drought Mitigation Center, Types of
Drought.
Bibliographic Entry on References Page

University of Nebraska-Lincoln: The National Drought Mitigation Center. Types of
Drought. 2014. http://drought.unl.edu/DroughtBasics/TypesofDrought.aspx.

Creating Bibliographic Entries for the References Page

To create bibliographic entries that reflect the sources in your footnotes, use the
“Manage Sources” feature in MS Word. By entering the source information here,
Word auto-generates the “References” page that appears at the back of the
document. To use this feature, follow these steps:
1.
2.
3.
4.
5.
6.

In your document, select the “References” tab in the ribbon.
Under “Citations & Bibliography,” open the “Style” dropdown menu.
Choose “Chicago Seventeenth Edition.”
Choose “Manage Sources.”
In the “Source Manager” window that opens, look for a matching source.
If no matching entry exists, add “New.”
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7. In the “Create Source” window that opens, choose “Type of Source.”
8. Fill in the form fields with information about the source.
9. Save and then check the newly created source for accuracy.
At this point, enter full bibliographic information about the source. When the source
includes a web address, spell out the fully qualified URL, which includes “http” or
“https,” but do not make this a hyperlink.

References Page

Once you have drafted your document and entered your sources and citations, you
can auto-generate the “References” page. To do this, follow these steps:
1.
2.
3.
4.

Position your cursor where the Reference page is to appear.
Select the “References” tab in the ribbon.
Open the “Bibliography” dropdown menu.
Choose “Insert Bibliography.”
Following these steps generates the “References” page according to our
bibliographic style. Remember to be sure that the bibliographic style selected in
your document is “Chicago.”

Referencing Legislative Statutes

The Authorities page of our plan documents includes a table of legal authorities,
usually legislative statute, that authorize the development of our plans. Follow the
format of existing plans, as well as the document template. For more information,
refer to the Legislation Navigation Guide, available in The Planner’s Toolkit on
TDEM’s website.

Web Pages, Hyperlinks and Websites

Use the footnote function in Word to insert links to web pages managed by outside
sources cited in the document. Include them in the references page. All references,
with or without embedded hyperlinks, to another organization’s web content refers
the user to the organization’s website, as shown below:
For more information, refer to Continuity of Operations Capabilities on the
FEMA website.

Tables

Tables are used whenever it is possible to clarify or simplify information by putting
it into tabular format. A table clarifies or efficiently communicates information in a
matrix, the result of data on one dimension intersecting data along another. By our
definition, a table is any presentation of information made up of rows and columns.
Plan documents contain several predefined tables that are filled in with data
collected from stakeholders during the planning process. Sometimes, however, the
need for a table arises from the text itself. Often this happens when discussing facts
or conditions that can undergo significant changes depending on other factors.
Rather than describing possible combinations in several paragraphs, consider
showing them in a table.
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If it is not obvious how to present the information in a table, or there are several
possible ways, try drafting some alternatives. Test them out before you devote too
much time to a single solution. To help organize your approach to the information,
try following these steps:
1.
2.
3.
4.

List the different ways the information can be broken into categories.
Check that all the information sorts into categories and nothing is left out.
Rank order the list of categories.
Make a table with the most important information across the top and the second
most important down the side.
5. Begin filling out the table, noting whether anything critical is lost.
6. If important information is lost, revise your categories and draft a new table.
So that screen-readers for the sight-impaired can translate the content of tables
into a voice recording, do not merge cells. This includes headers. The titles of tables
appear in the first column of the first row, or they can appear as a subhead above
the table, always followed by a sentence or two of text. Often, a table is preceded
by an introductory phrase, such as “. . . as shown in the table below” or “. . . as
outlined in the following table.”
The plan document templates include the tables that we use most often and which
you may copy to create others. To create a new table, choose the “Insert” tab in
the ribbon and click the “Table” dropdown menu. Follow the prompts to create your
table and use the Quick Styles to style it.
For more information on how to format a table, refer to Tables in the Visual Style
section below. For more information on tables and accessibility, refer to the
Accessible Style section below.
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Language Style Checklist

Use this checklist to help you check that your document follows our language style.
Language Style Checklist
Abbreviations and acronyms are used correctly and consistently.
Words are capitalized according to style.
Dates and times are properly and consistently formatted.
Lists are properly and consistently formatted.
Numbers are properly and consistently formatted.
Punctuation is used correctly and consistently according to style.
References and the references page is formatted properly.
Tables are styled appropriately and consistently.
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Common Terms and Usage

Certain terms are used often and consistently in emergency
operations plan documents. Following is a list of such terms.
Use the following list to learn the standard form and usage of commonly used
terms. Although this is not a comprehensive list, it does address many of the terms
that appear in plan documents. For more information, refer to the State of Texas
Acronyms and Terms (STAT) Book, which is available with the State Plan on the
TDEM website.

Annex/Appendix/Attachment

These three words mean different things to different audiences. The following table
explains how we use them in our plan documents.
Word
Annex

Appendix

Attachment

Usage
To describe a separate document that stands alone but has direct
relevance to the main document and may be written by a separate
author.
To describe reference information at the end of a document that does not
stand alone and does not need to be read to understand the main
document.
To describe something not included in the document itself, but attached
as a standalone form added to the document.

CBRNE

Use CBRNE, not CBRN, for chemical, biological, radiological, nuclear or explosives.

COOP

Continuity of Operations. Recovering and restoring an organization’s essential
functions, as distinct from emergency response and recovery.

COOP Unit

Continuity of Operations Unit. Capitalize “unit” when it is included as part of the
title. Lowercase “unit” when it is not written as part of a title, as in “The unit sent a
representative to the meeting.”

Deactivate

Deactivate is preferred over inactivate.

Decision-making, Decision-maker

Hyphenate when used as a compound modifier.

DoD

Department of Defense. Small o.
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DPS

Abbreviation for Texas Department of Public Safety.

ePlan

The TDEM Emergency Plan Management System, which enables emergency
coordinators across the state to submit emergency plans to TDEM.

ESF-1

Use the hyphen, no space. Federal documents often use the pound symbol (#),
prior to the first digit. We do not.

ETN

Emergency Tracking Network; Formerly Texas Emergency Tracking Network
(TxETN)

Evacuee(s)

Avoid this term since it may not be an accurate description people can be affected
by an incident without being evacuees. Use “people affected by the [incident]”
instead.

FEMA Regions

Use Roman numerals, such as I, II, III, when referring to FEMA regions.

Full-Scale

Hyphenated, as in full-scale exercise.

Green Book

Introduce as the ESF Crosswalk Reference Guide (Green Book), and use Green
Book thereafter. As with acronyms, reintroduce in new sections.

Inactivate

We prefer deactivate over inactivate. See Deactivate above.

Interjurisdictional
Do not hyphenate.

Local and Regional Plans Unit

Do not use LRPU except in internal or informal communication. Capitalize “unit”
when it is included as part of the title. Lowercase “unit” when it is not written as
part of a title, as in “The unit sent a representative to the meeting.”

More than versus over

To express quantities, use more than:
“They sheltered more than 15,000 evacuees.”
Over refers to relative position.
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Multi-agency
Hyphenate.

Multijurisdictional
Do not hyphenate.

Over

See More than versus over.

Planning team

A generic reference to the people who work with us on our annexes.

Plans team

A specific reference to the Local and Regional Plans Unit, the State and Federal
Plans Unit, the Plans Management Unit and the Continuity of Operations Unit.
Capitalize Plans team as the informal name of a specific group.

Population, residents

Use “population” to refer to a large, general group. Use residents, rarely, to refer to
individuals living in a geographic location.

Predesignated

Do not hyphenate.

Pre-identified
Hyphenate.

Should

Does not appear in the State of Texas Emergency Management Plan or its annexes
because these documents are not prescriptive. Local guidance documents may use
“should” when necessary.

SITREP

Abbreviation for situation report.

State and Federal Plans Unit

Do not use SFPU except in internal or informal communication. Capitalize “unit”
when it is included as part of the title. Lowercase “unit” when it is not written as
part of a title, as in “The unit sent a representative to the meeting.”

Storm Names

Use storm names provided by National Oceanic and Atmospheric Administration
(NOAA).

Tabletop

One word, as in tabletop exercise.

TTE

Abbreviation for test, training and exercise.
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Texas A&M AgriLife Extension Service
Note capital L in AgriLife.

Texas Division of Emergency Management (TDEM)
Texas Highway Patrol

Do not write Texas Department of Public Safety—Highway Patrol. Spelled out, write
Texas Highway Patrol; however, the short form is DPS-THP.

TSA

Abbreviation for The Salvation Army; do not abbreviate as SA.

Tribal

Include the word tribal everywhere we write the words federal, state and local. For
example: Federal, state, tribal and local jurisdictions are invited to comment.

TxDOT

Use lowercase x per TxDOT’s preference.

TxETN

Do not use. Refer to ETN above.

TXMF

Texas Military Forces.

U.S.

Use with periods or, rarely, USA without periods.

Utilize

Do not use. In most cases, the word use is sufficient.

Victim(s)

Do not use. Instead refer to people (or the population) affected by [the disaster].

Website

One word. Use to refer to Web content provided by another organization. For more
information, refer to Web Pages, Hyperlinks and Websites in References above.

Wildland fire

Wildland fire is preferred over wildfire. These terms are not interchangeable.
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Visual Style and Formatting

This section presents standards and guidelines for using graphics
and images to develop effective, user-friendly documentation.
Good document layout and design standards are developed for clarity and
accessibility. Specific colors and fonts are selected to ensure that documentation
and communication present a consistent identity to internal and external audiences.
The program design for the TDEM Preparedness Section documentation meets the
following objectives:
 Visually clear and uncluttered
 Accessible according to 508 guidelines
 Flexible enough to accommodate a wide array of document types and design
problems
 Easily implemented with a basic word processing program
 Easily maintained
 Easily used by non-specialists

Design Elements

Preparedness Section documentation relies on a variety of design elements and
features to achieve a clear, accessible and user-friendly look. The following table
shows how each element contributes to this effect.
Design Element
Alignment and
Layout

Text is set flush left, ragged right, top aligned because it is the
most familiar and the easiest to manipulate. The text block is set
this way. Pages are top aligned and ragged bottom to facilitate the
“chunking” of information and open up the page layout overall. A
whiter, more open page helps prevent the user from feeling
overwhelmed by the content.

Borders and
Rules

Borders, also known as rules, are used to separate sections of text
and within tables for ease of navigation. They are used sparingly.

Bullets and
Numbers
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Rationale

Bullets and numbers are used to set off items in vertical lists.

Color Palette

Color is used when it serves a functional purpose. Color is used in a
way that does not cause problems for colorblind users and which is
discernable in a variety of formats, media and reading conditions.

Diagrams

Diagrams and process flow charts are used to present important or
complex procedural information and to reinforce written text. A
standard software tool and a simple, familiar symbol system are
used to facilitate understanding.

Fonts

To help streamline reading and to support the use of reading assist
software for the visually impaired, all planning documentation uses
the type font Verdana, an industry standard for clarity and
legibility. Fonts in table headers are reversed out (white) of the
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Design Element

Rationale
document color to help distinguish the header from the rest of the
table. Within documents, font sizes range from 18 pt. for the
section headers to 10 pt. for table text and captions. The main text
font is 11 pt., which follows 508 accessibility recommendations. We
do not underscore, all-cap or boldface words for emphasis and
rarely use italics for this purpose.

Images and
Captions

Images, such as photographs and illustrations, are used sparingly
and when used convey important information. They are not used in
a purely illustrative or decorative way. Captions briefly describe the
information conveyed by the image.

Navigation
Devices

All documents employ navigation tools that help the user find
content within the document and locating additional content outside
the document.

Pull quotes

Pull quotes are set in a large boldface font just beneath the section
heading. Highlighting this information allows the reader to quickly
preview the content of the section.

Section Headings

Tables

Section headings clearly announce the beginning of the primary
sections in any document. They appear in a large, bold font and are
followed by a pull quote and a rule.
Tables are used to clarify and streamline information. Tables
contain as few hyphenated words as possible. Column widths are
standardized or are distinctly different to maintain clarity. A menu
of table styles has been developed to maintain a consistent style
and brand, as well as to ensure their appearance remains as clear
and open as comprehension allows.

The remainder of this section provides guidelines for many of the design elements
in the table above, as well as for other important elements of visual design and
communication.

Alignment and Page Layout

Page margins maintain the MS Word default setting of one inch (1”) on all sides.
The main text block is set flush left, ragged right. The preferred width is six-andone-half inches (6.5”). This width applies to tables, borders and rules also.
Pages are set top aligned, ragged bottom, which means that the text block need
not touch the bottom margin of the page. This gives planners the flexibility to shift
a heading from the bottom of one page onto the top of the next to prevent a bad
break. Avoiding such discontinuities facilitates the “chunking” of information while
opening up the pages overall.
Bullets and numbers sit outside the text block in the left margin. This is because
the eye more easily absorbs information that aligns on a clean, vertical edge than if
the content itself is indented.
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Titles as they appear on covers and title pages are set flush right as a consistent
branding element. In some tables, the text in the first column is set flush right to
highlight or make a distinction about the information in the first column or simply to
aid reading and navigation.

Removing Bad Breaks

As a document nears its final review stage, the planner scans it for bad page
breaks. These are pages with a major heading on the last line or just a few lines of
type at the top of the page. Look for a logical break and insert enough line spaces
or a page break to remove the bad break. It may save time to reduce the document
size on your screen to 50 or 60% so that it is easier to scroll through and spot bad
breaks.
Another way to remove a bad page break is to edit the copy so that it fits the
space. Use this approach to edit tables and diagrams to fit a given space so that
there is a natural break and big chunks of content hold together visually.
Remember that every time content is added to or subtracted from a document, it
must be quickly scanned for any newly created bad breaks.

Borders and Rules

Borders and rules, or lines, are the main graphic elements that separate text. Apart
from covers, documents use two standard line weights: ¾ point and 2 ¼ point.If
possible we do not use vertical divider lines or outlines unless they are necessary
for clarity.
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Bullets and Numbers

Bullets and numbers are used to make vertical lists easier to find and read. Bullets
and numbers never begin a main section but are usually introduced by normal text.
For more information on writing and punctuating bulleted and numbered lists, refer
to Lists above.
Numbers are used in lists only when they denote sequence, as in a series of steps.
Try to use no more than nine steps and few, if any, subordinate steps. Often more
complex processes are best presented in a diagram. Bulleted or numbered lists are
no more than two levels deep.

Color Palette

Our documentation draws on two colors that together brand and distinguish a wide
array of document types and information: Preparedness Blue and black. These
colors satisfy the following criteria:





Utility

Clearly distinct colors
Meet 508 accessibility guideline criteria for color blindness/contrast
Web-safe, easily adapted to a broad range of viewing environments
Strong enough to remain distinct across a wide range of shades and tints
Preparedness Blue is the color used in most documents. It is used with black or
gray (tints of black).
Preparedness Blue

RGB 0, 51, 153

Choosing and Changing Colors

To change the color of text, follow these steps:
1.
2.
3.
4.
5.
6.
7.

Highlight the text.
On the home ribbon, choose the “font color” dropdown menu.
Choose “More Colors.”
Open the “Custom” tab.
Make sure “RGB” appears in the “Color model” dropdown menu.
Enter the desired color’s RGB numbers into the Red, Green and Blue text fields.
Press “Enter” and the text changes color.

Diagrams

Planners create pictures, or diagrams, of complex processes and relationships,
using the common software tool Microsoft Visio and a standard set of symbols.
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Process Diagram Basics

Process diagrams, or flow charts, are oriented first by time, which flows down the
page, and then by functions or agents, which are arrayed across the top of the
page. Vertical columns, or “swim lanes,” mark off each agent’s area of
responsibility or control, as shown in the following example.

The shapes in the swim lanes represent activities, decisions or documents. They are
connected by lines that indicate the process flow. The following table defines each
shape and how it is used.
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Creating Diagrams in Visio

Formatting generally follows our style for tables, as reflected in the following basic
settings:
 Headers and titles are set in Verdana, 11 pt., bold, white, on document color.
 Text within the diagram is set in Verdana, 10 pt., or 9 pt., at minimum.
 The “yes” and “no” text at decision points is set in Verdana, 9 pt.
When you create a Visio diagram, think about its final size in the document. Visio
tries to fit the file in the space available, which may reduce font and line sizes to
near illegibility. Diagrams are not more than six inches wide or eight inches deep.
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Opening Visio to create a file prompts the user to make some format choices.
Choose the following options:











Choose cross-functional with band orientation set to vertical.
In each band, list each function or agent in the function boxes.
Use the y-axis for time.
Use the x-axis for function.
Use the Basic Flowchart Shapes, in U.S. units, in the flowchart shape menu.
Use Classic small border, without a background, as a frame.
The outside border is in the document color, 0.75 pt.
Color can be adjusted under format > line > color.
Line weight can be adjusted under format > line > weight > custom.
Terminator oval shapes are Verdana, 10 pt., bold, white, on document color.

Inserting, Linking and Updating Diagrams in Plan Documents

Unlike charts and tables, Visio diagram files are treated as source files and are
stored in a separate graphics folder within the document’s file folder structure. In
the plan document, insert a link to the Visio source file so that a copy of the
diagram appears in the document. To do this, follow these steps:
1.
2.
3.
4.
5.

Position your cursor where the diagram is to appear in the document.
On the Insert tab, select “Object” from the Text section.
Select the “Create from File” tab.
Click “Browse” and navigate to the Visio file.
Select the file and click the “Link to file” box.
Changes to Visio source files do not automatically push to all linked objects in all
documents. To update a Visio object in a document, follow these steps:

1. Right click the Visio object in the document.
2. Choose either “Update link” to update the object or “Linked Visio Object” > “Open
link” to compare the object with the source file.
To share copies of a Visio diagram outside your immediate work group, save a copy
of the source file in another file format, such as TIFF or JPEG, so there is no danger
of compromising the source file.

Fonts

To help streamline reading and simplify document preparation, the standard type
font for all planning documentation is Verdana. This versatile font has become an
industry standard for legibility and readability. Also, it responds to Section 508 of
the Rehabilitation Act of 1973, which helps ensure our documents are accessible to
the entire community of potential users. For more information on 508 compliance,
refer to Accessible Style below. We do not underscore, all-cap, small cap, or
boldface words for emphasis.
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Font Color

Body text is black. Headings are set in Preparedness Blue as described above. Fonts
in table headers are boldface white (reverse) against the document color to help
distinguish the header from the rest of the table.

Font Size

Within documents, font sizes range from 9 pt. in Visio diagrams to 18 pt. for the
section headers. The main text font is 11 pt., which complies with 508 accessibility
recommendations. Footnotes and captions appear in 10 pt. font.

Font Styles and Formatting

We use Word document templates to create different types of documents. These
templates are preformatted with Quick Styles selected from the “Styles” menu on
the ribbon. The document templates identify the style by name and provide
additional guidance about using them.
Since these styles are built into the templates, you do not need to know the style
settings themselves; however, it is essential that you apply quick styles properly in
order to produce a correct, internally-consistent and professional document. For
more information, refer to Appendix A: Format Settings.
To check whether headings are correctly styled, update the document’s table of
contents by selecting it and choosing “Update Entire Table.” Compare the table of
contents headings to those in the rest of the document, as well as an example of a
similar document. Make sure the table of contents is complete and correct.

Images and Captions

Images include photographs, illustrations, some charts and other forms of graphic
art that are prepared by others or come from an outside source. Diagrams and
Maps are discussed separately.
Photographs can enliven a document but should also convey information.
Photographs and illustrations from outside sources are usually protected by
copyright. Photo permission and source information must be documented.
Keep the following points in mind while developing and adding images to a
document:
 Document the image’s source, whether internal or from another source.
 Keep a file with information on who gave written permission to use it, when and
under what circumstances.
 Do not assume an image is in the public domain (freely available) or that it may be
used without permission because it appears in a government publication.
 Avoid images with corporate names and logos unless these are essential to the
image’s meaning and value.
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Appearance and Layout of Images

Images are included when they convey useful or contextual information. Follow
these guidelines for ensuring that images contribute to the professional appearance
of your document:
 Make sure the original image file presents a clean, clear and sharp image.
 Position images flush left on the page.
 Extend the image to cover about half (3.5”) or all of the page (6.5”), left to right,
as described under Inserting and Resizing Images below.
 Be sure that words and numbers meant to be read are at least 9pt.

Image Format

Consistent formatting gives images a uniform, professional appearance. Keep the
following image format guidelines in mind:






Use images with a resolution of 300 dots per inch (DPI) or higher for printing.
Keep images close to their original size to reduce degradation.
Images that are to be viewed online only may have resolutions as low as 72 DPI.
Acceptable image file formats include bitmap (BMP), GIF, JPEG, PNG and TIFF.
Do not use images copied from websites, as they may be too small and may distort
when printed.

Inserting and Resizing Images

Insert images from files, not from clip art or with a link to a Web page. To insert
and resize an image in your document follow these guidelines:
1.
2.
3.
4.
5.
6.
7.
8.

Place the cursor where you want the image to appear.
Choose “Insert” and “Picture” in the ribbon.
Select the image file to insert it on the page.
Right-click the image.
Choose “Size and Position” and check “Lock aspect ratio.”
At “Absolute width,” enter 3.5” for a half page or 6.5” for a full page.
On the “Text Wrapping” tab, choose “Tight.”
On the “Position” tab, set the horizontal “Absolute position” to “0.”
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Reposition the image relative to your text as needed. We discourage text wrapping
because it can create a busy, hard-to-read page and complicate its accessibility.

Inserting Image Captions

All the images in your document must have captions. Tables, maps and diagrams,
however, do not receive captions. Use the following procedure to create captions:
1. Right-click the image.
2. Choose “Insert caption.”
3. In the dialog box that opens, insert two spaces after the figure number, and enter
your caption and click OK.
4. In the caption itself, format the text: Verdana, 10 pt., regular, preparedness blue.

Figure 1 Mobile medical unit personnel must
remain focused, sharp and calm to be
effective.

Microsoft Word gives captions figure numbers, which are useful when referring to
particular images. For more information on writing informative captions, refer to
Accessible Images and Captions below. For information on applying the document
color, refer to Choosing and Changing Color above.

Maps

Maps that are created for the state’s emergency operation plan exhibit the same
look and feel as our other documents and graphics. Our standards also guide
specialists in creating 508 compliant cartographic products that meet the needs of
individuals with visual impairments. We provide geographic information systems
(GIS) users with a tool to help them produce and organize map documentation that
is consistent with our standards.

Tables

Tables follow a specific format so that screen-readers can translate them into voice
recordings for the sight impaired. For this reason we never merge table cells. In
other words, tables have a consistent number of columns and a consistent number
of rows throughout the table. For more information on writing and styling content
Documentation Standards
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for tables, refer to Tables in the Language Style section above. For more
information on making tabular information more accessible, refer to the Accessible
Style section below.
Our tables are designed to be clear, open and consistently styled. The following
table presents our typographical standard for tables.
If a table breaks across a page, make sure the first row, or header row, of the table
is selected to “Repeat as header row at the top of each page.” This option appears
under “Table properties” > “Row.”

Element

First Row
Font

Verdana 11 point bold, white
on document color fill (see
Borders and Shading below).

Verdana 10 point regular, black;
use boldface, document color, in
column one when it serves as a
secondary header.

Paragraph
Settings and Cell
Margins

Paragraph line spacing:
“single,” 3 left, 3 right, 3 pt
(points) before, 5 pt (points)
after.

Set paragraph line spacing at
“single,” 3 left, 3 right, 3 pt
(points) before, 5 pt (points)
after.

Text alignment: centered
horizontally and vertically.

Left align all text. In some tables,
where the first column contains
labels, the first column may be
right aligned. In those cases use
bold text.

Text Alignment

Row Height

Column Width
Borders and
Shading
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Remaining Rows

“at least 0.21.”

The content of each cell
determines the height of a given
row.

Variable; avoid two-line
headers.

Variable; however, maintain the
column widths of standard tables.

Use the document color as
the fill for the header row.

Use the document’s color for all
horizontal border lines. Line style
is solid and line weight is 3/4 pt.
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Visual Style Checklist

Use this checklist to help ensure that your document follows our visual style.
Visual Style Checklist
The document is properly formatted in the appropriate template.
Text is left aligned, ragged right.
Pages do not appear dense or text heavy.
Bad breaks have been eliminated.
Borders and rules follow design style.
Bullets and numbered lists follow design style.
The color palette is correctly applied.
The font Verdana is used throughout.
Images are inserted and sized properly.
Tables are formatted correctly.
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Accessible Style

This section presents guidelines for ensuring our documents are
accessible to all potential users and comply with Section 508 of the
Rehabilitation Act of 1973.
Documentation standards and guidelines help ensure that our communication
products are accessible to the widest audience possible.
For this reason, we strive to comply with Section 508 6 of the Rehabilitation Act of
1973, as amended (29 U.S.C. 794d). 7 Texas has enacted similar legislation that
applies to all state agencies. Section 508 stipulates that content be developed to
meet the following objectives:
 Content is clear, legible and facilitates comprehension for the widest audience.
 Content translates easily into alternative formats in order to reach users who would
otherwise have no access to it.

Assistive Technology

Assistive technology translates information for many people who would otherwise
be denied access to it. For example, screen readers allow navigation within a page,
announce bulleted lists and tables, spell words, and can be set to read at different
speeds. However, screen-reader software only pauses for headings, lists and tables
that contain punctuation. Without these cues, information can sound like a random
string of words.

General Guidelines

Use the following guidelines to help ensure your document is accessible:






Punctuation pauses screen readers, so include suitable punctuation.
Avoid special symbols because they are not recognized by assistive technologies.
Do not abbreviate dates because of differing American and European styles.
Acronyms and abbreviations are all caps, no periods or spaces.
Do not save documents as “Read-only,” since this prevents assistive technology
from accessing the document.
The table below provides examples of how our style responds to 508 guidelines.
Standard

Non-Standard

and

&

approximately

~

GPA

G.P.A. or G P A

December 1, 2013

12/1/14

6

For more information, refer to U.S. Department of Health & Human Services, Section 508.
Read about the Texas Accessibility Statute at
http://www.statutes.legis.state.tx.us/Docs/GV/htm/GV.2054.htm
7
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Accessible Images and Captions

Images, such as photos or illustrations, present a challenge because they are not
accessible to all users. If you use an image, write a descriptive caption to help
readers understand its meaning and context within the document.

A caption for this photo might read like this:
Figure 1 Canned food at a shelter

A more descriptive caption reads as follows:
Figure 1 Personnel prepare for large quantities of donated food by quickly unpacking
and arranging it as it arrives.

Alt Text

In addition, add alternative text, also known as alt text, to images so they are
accessible to the visually impaired. Alternative text is read aloud by screen readers.
Write alt text in order to describe the picture to a reader who is not looking at it.
Alt text for the image above might read as follows:
Image of a large, open room resembling an empty department store. The
room is set up with rows of folding tables stacked with great quantities of
canned goods. Used, empty boxes are loosely stacked against a far wall.
To insert alt text, follow these steps:
1.
2.
3.
4.

Right-click on the image and choose “Format Picture.”
Click “Alt Text.”
Enter the title, which is the Figure number and caption.
Enter the alt text under “Description” and click “Close.”
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Accessibility Checklist

Use this checklist to ensure your documents are accessible and respond to Section
508 guidelines.
Accessibility Checklist
Text layout is clear, simple and consistent.
All images and graphics appear crisp and legible.
All pages are oriented either vertically or horizontally.
All text is formatted according to existing template styles and guidelines.
The main text is set flush left, ragged right.
There are no textboxes.
The table of contents is created using the automated function.
Footnotes are inserted using the automated function.
Tables follow the format outlined in the Visual Style section above.
File names follow the format outlined in the Getting Started section above.
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Pre-Review Checklist

Prior to sending your document out for review, scan this checklist to
make sure it is in top-notch form.
Use this checklist to ensure a document is ready for supervisor, stakeholder or
public review. This list includes a few items that do not appear elsewhere.
Pre-review Checklist
In track changes mode, delete all addressed comment boxes.
Accept all accepted changes.
Make sure the track changes feature is turned off.
Search for “TK,” “will” and “should.” Edit as needed.
Make sure the planning assumptions are logical and clear.
Check all lists, tables and illustrations for proper formatting.
Make sure footnotes and citations have been entered properly.
Make sure citations are properly entered and formatted.
Make sure color is used properly and consistently throughout the document.
Make sure all other design elements reflect the visual style.
Make sure all text is in Verdana according to font style.
Make sure images are formatted properly.
Review the accessibility checklist for any accessibility issues.
Schedule time for another planner to review the document.
Incorporate final edits and perform a final grammar check.
Scan the entire document for bad page breaks and adjust as needed.
Select and update the entire table of contents, not just the page numbers.
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Maintenance and Changes

This section describes the process by which this document is
maintained and updated.

Development
The Preparedness Section developed this document to support the credibility and
utility of the State of Texas Emergency Management Plan, including the Basic Plan,
its emergency support function annexes, support annexes and hazard-specific
annexes. This document also guides general documentation and communication in
the Preparedness Section.
While the section’s document types vary in content, they share fundamental
similarities in basic construction. These Documentation Standards are designed to
help users produce documents that are accurate, consistent, communicative yet
user-friendly.

Maintenance
This is a living document. The Preparedness Publications Management Unit is
responsible for changes to it. The unit maintains the document and coordinate
updates after receiving feedback from TDEM.
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Record of Changes

This section describes changes made to this document: when they
were made, what they were, and who authorized them.
Use this table to record the following information:





Change number, in sequence, beginning with 1.
Date change was made to the document.
Description of change and rationale if applicable.
Initials of person who made the change.
Number

Date

1

12/01/17

Description
Minor updates and edits for brevity and to style
direction, voice and references.
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WRW
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For More Information
For more information on this document contact Rory Halpin, Strategic Planning
Unit Supervisor, at rory.halpin@tdem.texas.gov.
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